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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage 
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the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
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CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance 
are required to ensure that the products operate safely and without any problems. The permissible ambient 
conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may 
be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
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Preface

Purpose of this Document
Purpose of this Document
This document provides information necessary to setup PCS 7 Open OS for  9.0.

Required Basic Knowledge
Readers are presumed to be expert in the use of PCS 7 and the target system. 

Where is this Manual valid?
This manual is valid for the software package PCS 7 Open OS for 9.0.

Training Centers
Siemens Technical Training Centers provides extensive training for all levels of plant personnel 
to ensure optimal performance from PCS 7 control systems. Classes include extensive hands-on 
activities using appropriate equipment, making the training directly and immediately applicable.
Information is available online (http://www.sitrain.com).
Siemens also offers a number of training courses to familiarize you with the SIMATIC S7 
automation system. Please contact your regional training center or our central training center 
in D 90327 Nuremberg, Germany, for details: 
Telephone: +49 (911) 895-3200 or see the Internet site (http://www.sea.siemens.com/sitrain).

A&D Technical Support
Worldwide, available 24 hours a day:
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United States: Johnson City, TN Worldwide: Nürnberg Asia / Australia: Beijing
Technical Support and Authorization
Local time: Monday to Friday 
8:00 AM to 5:00 PM
Telephone:+1 (423) 262 2522
or +1 (800) 333-7421 (USA only)
Fax:+1 (423) 262 2289
An Internet site is available for support 
requests (http://www.siemens.com/
automation/support-request).
 

Technical Support 
24 hours a day, 365 days a year
Phone:+49 (180) 5050-222
Fax:+49 (180) 5050-223
Email for technical support 
(mailto:ad.support@siemens.com).
GMT:+1:00

Technical Support and Authorization
Local time: Monday to Friday 
8:00 AM to 5:00 PM
Phone:+86 10 64 75 75 75
Fax:+86 10 64 74 74 74
Email for technical support 
(mailto:ad.support.asia@siemens.com).
GMT:+8:00

Automation and Drives Service and Support International (http://www.siemens.com/automation/service&support) 
The languages of the SIMATIC Hotlines and the authorization hotline are generally German and English.
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Security information 1
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks.
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security 
concept. Siemens’ products and solutions constitute one element of such a concept.
Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. Such systems, machines and components should only be connected to 
an enterprise network or the internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.
For additional information on industrial security measures that may be implemented, please 
visit 
https://www.siemens.com/industrialsecurity. 
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats.
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
under 
https://www.siemens.com/industrialsecurity. 
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Introduction 2
2.1 Scope of this Document

This document outlines the steps required to set up a PCS 7 system and a corresponding PCS 7 
project that is integrated with third-party devices. Project development is done on an OS 
Engineering Station using SIMATIC Manager. This document is based on the architectural layout 
below. A client and your engineering station may be the same physical computer. The diagram 
below shows them to be on different computers.

Note
For further information on a specific topic in this document, refer to the documentation on the 
PCS 7 V8.2 DVD set, the WinCC Information System or in the documentation 
folder Start >Siemens >Documentation >English on the hard drive. 
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2.2 Security

2.2.1 Security Concept
The security concept of SIMATIC PCS 7 should be considered as a set of recommendations and 
is intended to support SIMATIC customers in creating a network for production plants fulfilling 
higher security requirements. The recommendations are based on the latest technology, current 
standards and the features of the employed products.
Since the threat to security is constantly changing, even a complete implementation of the 
security concept cannot permanently guarantee complete and one hundred percent protection. 
We therefore recommend a regular evaluation of the measures implemented as part of the 
security concept.
PCS 7 Security Concept Recommendations and Notes:
http://support.automation.siemens.com/WW/view/en/22229786 (http://
support.automation.siemens.com/WW/view/en/22229786)
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2.2.2 PCS 7/Open OS Example

Figure 2-1 Security Picture_Open OS
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2.2.3 General Security Information
Siemens offers IT security mechanisms for its automation and drive product portfolio in order to 
support the safe operation of the plant/machine. Our products are also continuously developed 
further with regard to IT security. We therefore recommend that you keep yourself informed 
about updates and upgrades for our products and always use the latest version of each product. 
You can find information on this at:
http://support.automation.siemens.com 
You can register for a product-specific newsletter here.
For the safe operation of a plant/machine, however, it is also necessary to integrate the 
automation components into an overall IT security concept for the entire plant/machine, which 
corresponds to the state-of-the-art IT technology. 
You can find information on this at: 
http://www.siemens.com/industrialsecurity

Products used from other manufacturers should also be considered here.

Below you’ll find a list of special attention points towards security when installing and using 
PCS 7/Open OS:
• Ensure integrity of the files exchanged between systems. It is crucial that enough measures 

are taken to ensure that the data in those files cannot be tampered with. Examples are 
external files from other systems that are read by PCS 7/Open OS, such as CSV files that 
contain configuration data. Other examples include xml, CSV and ZIP files delivered from the 
PCS 7/Open OS system like DBA archive files and exports from DBA. Consider using a 
password protected container when exchanging such files between systems.

• Do not adapt the PCS 7/Open OS installation / upgrade files. To install / upgrade the PCS 7/
Open OS system properly with all the required build in security, it is important that these 
files are not changed. Therefore, it is the responsibility of the customer to ensure that the 
person in charge of this process understands this measure. In some exceptional cases the 
installation documentation may request some files to be changed manually. The instructions 
for manual changes must be strictly applied.All other changes are not allowed. In case of 
issues with certain files always contact Siemens support.

• When establishing connections to third-party systems, follow the security recommendations 
of the third-party vendor.

• PCS 7/Open OS supports secure OPC connections for data access to OPC Unified Architecture 
(UA) Servers. For alarm and event data, if secure connections are required, it is necessary to 
configure alarms to be triggered from tag changes originating from an OPC UA server, since 
secure connections to OPC Alarm & Events servers are not possible.
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2.3 Software Installation Overview
PCS 7/Open OS can be installed as a PCS 7 Single Station or in single or redundant client server 
architectures. The table below describes the various components that need to be installed. 
Depending on the architecture of your system, these components may need to be installed on 
the different computer nodes in the architecture.

Note
Note that all steps might not be required:
• If your computers have been pre-installed with the correct version of the Operating System, 

the installation of the Operating System is not required and Step 1 can be skipped.
• If you require no third-party software, Step 2 can be skipped.

Step Procedure Section
1 Installing the Operating System (Page 15) 2.3.1
2 Installing Third-Party Software (Page 15) 2.3.2
3 Installing PCS 7 Software (Page 16) 2.3.3
4 Installing PCS 7/Open OS Software (Page 16) 2.3.4
5 Installing Authorizations and Licenses (Page 26) 2.3.5

2.3.1 Installing the Operating System
The following operating systems are supported by PCS 7/Open OS OS V9.1:
• Windows 10 Enterprise LTSC 2019
• Windows Server 2019 Standard Edition 
• Windows Server 2019 Datacenter Edition
For detailed installation instructions regarding the installation of the operating system,
• pcs7-offlinereadme.mht in the root directory of the PCS 7 Installation media (PCS7 V9.1)
• SIMATIC PCS 7 installation path in the folder _Manuals\English PCS 7  PC-Configuration.pdf

2.3.2 Installing Third-Party Software
Third-party software (for example, Microsoft Office, PC Anywhere, Virus softwar) should be 
installed prior to installing PCS 7. Refer to the PCS 7 Readme and PCS 7 PC-Configuration PDF file 
for further information.
Third-party OPC Servers or WinCC Channel drivers may also need to be installed.
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2.3.3 Installing PCS 7 Software
For detailed installation instructions, refer to 
• pcs7-readme.mht in the root directory of the PCS 7 Installation media (PCS 7 V9.1)
• SIMATIC PCS 7 installation path in the folder _Manuals\English PCS 7 PC-Configuration.pdf

Note
Select the appropriate software packages during PCS 7 software installation. Use the 
following as a guide:
• Engineering Node - Select PCS 7 Engineering
• OS Servers - Select OS Server
• OS Clients - Select OS Client
• Process Historian – There are no software components that need to be installed on the 

Process Historian.
However, the Archive Server must be at PCS 7 9.1

2.3.4 Installing PCS 7/Open OS Software

Note
Prior to installation of this software, login with Administrator rights and disable any virus 
protection software that is currently running. In addition, this software should be installed after 
all other PCS 7 software has been installed. Ensure that all PCS 7 log on activity is complete. Refer 
to the PCS7_Open_OS.RTF (readme file) on the installation media for more information.
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1. Insert the PCS 7 Open OS USB stick into USB drive.
The setup program automatically starts and a language selection dialog box opens.

Select the installation language (English or German) of your choice. 
The Welcome dialog box opens.
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2. Click the "Next" button to continue. 
The Product Notice dialog box opens.

Introduction
2.3 Software Installation Overview

PCS 7/Open OS Setup Guide
18 Equipment Manual, 11/2021, A5E51387645-AA



Introduction
2.3 Software Installation Overview

PCS 7/Open OS Setup Guide
Equipment Manual, 11/2021, A5E51387645-AA 19



3. To view the release notes, click the button labeled "Yes, I would like to read the notes button". 
Click the "Next" button to continue. 
The License Agreement dialog box opens.
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4. Read the license agreement. Select the button labeled "I accept the conditions of this license 
agreement".
Click the "Next" button to continue. 
The Setup type window opens.
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5. Select the setup type. Click the "Next" button to continue. 
The User information dialog box opens.
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6. Enter "Name" and "Company". Click the "Next" button to continue.
The Installation type dialog box opens.
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7. Select the installation type and click the Next button. If Package Installation is selected, the 
Program packages dialog box opens. If User-defined installation is selected, the install 
program proceeds directly to the Programs dialog box (step 8).
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8. Select a suitable package for the computer on which this installation is occurring by clicking 
the appropriate check box. 
The Programs dialog box opens.
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9. Click the "Next" button to accept the programs to be installed. 
The Ready to install the selection dialog box opens.

10.Click the "Install" button to begin the installation. 
The package installation begins. The installation runs to completion. At the end of the 
installation you may be asked to reboot the computer. Remove the USB stick from the USB 
drive and reboot the computer if asked.

2.3.5 Installing Authorizations and Licenses

Note
Each PCS 7/90 OS Software package may include a License Key memory stick. As you install the 
various packages, be sure to install the license disk with that package.

1. Insert the License Key memory stick that came with your software into USB port.
2. From the Windows taskbar, click "Start" button and navigate to SIMATIC > License 

Management > Automation License Manager.
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3. Double-click the USB drive containing the License Key memory stick.
4. Select all of the authorizations.
5. Transfer the authorizations from the USB drive to the target drive.
6. Remove the License Key memory stick from the USB port.

Introduction
2.3 Software Installation Overview

PCS 7/Open OS Setup Guide
Equipment Manual, 11/2021, A5E51387645-AA 27



Introduction
2.3 Software Installation Overview

PCS 7/Open OS Setup Guide
28 Equipment Manual, 11/2021, A5E51387645-AA



Updating a Project from V8.2.1 and V9.0 to V9.1 3
3.1 Updating WinCC OS Projects

Procedure

Note
This procedure is not necessary when upgrading a project from PCS 7/Open V8.0.

1. Run the Project Migration Wizard, particularly for OS projects created prior to WinCC V6.2.  Do 
this by selecting Start > SIMATIC > WinCC > Tools > Project Migrator.  

2. Navigate to the path of the .MCP file for this OS project (for example, the  file OS(1).mcp in 
folder C:\Program Files\Siemens\Step7\S7proj\OPEN_1\OPEN_Prj\wincproj).  

3. Accept defaults for all options.
    

3.2 Updating Basic Data of an OS Project

Backing up System Files
In this step, the OS Project Editor copies newly installed pictures, faceplates, and action scripts 
into your existing project. This operation ensures that your project has the latest features and 
that the files are consistent for correct runtime operation.
However, the copy operation can also overwrite any system files that you have changed. To avoid 
loss of your work follow the steps below carefully and observe the following precautions:
• Copy any changed files in the OS project’s GraCS folder and save them in another folder. In 

particular, save a copy of @@MyProjectTypicals.pdl and/or any other project-specific typicals 
files.

• Archive the project as described in Section 1, before doing this step.
• Use the "Cancel" button to exit the OS Project Editor if you are unsure which files will be 

overwritten. If you exit by clicking the "OK"  button, the file copying and overwriting proceeds.
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Procedure
1. Open the OS Project Editor: in the SIMATIC Manager project component view right-click the 

OS and select Open Object to open WinCC Explorer to this project. In the left pane of WinCC 
right-click the OS Project Editor and choose Open.

2. Open the General tab and in the Activities frame at the top select the option Complete 
Configuration (loss of support for online DeltaLoading).

3. Open the Basic Data tab. The four panes show lists of the files that differ in timestamps 
between the newly installed files (from the "Product") and those in your existing files (from 
the "Project"). A checkmark in the box means that the project file will be overwritten by the 
newly installed ("delivered") file. You should accept the defaults unless you are sure you want 
to retain a project file, in which case you may clear the box. Note that checked entries that are 
marked with a red cross may not be cleared (to preserve runtime consistency). These project 
files will be overwritten; therefore, you must copy them elsewhere if you want to preserve 
them. For further details, select any control on the dialog and press the F1 keyboard key for 
help, and click the link at the bottom for help on the Basic Data Tab. Refer to the illustration 
of the Basic data Tab below.

4. Click the "OK"  button to exit the dialog and update the OS project, or click the "Cancel"  button 
to exit with no changes.

Updating a Project from V8.2.1 and V9.0 to V9.1
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3.3 Updating the Block Icons (Symbols) in Project Pictures
When the newly installed block icons differ from those in existing OS project pictures, if you wish 
to use the new ones, follow this procedure to replace the block icons in these pictures.

Procedure
1. On the ES station, open the OS project in WinCC Explorer, then select the Graphics Designer 

editor in the left pane.
2. In the right pane double-click any PDL file of the project to open Graphics Designer.
3. In the Dynamic Wizard toolbar select the Picture Functions tab, then double-click the 

function Update of the picture objects. If the toolbar is not visible, choose the menu 
command View > Toolbars..., and select Dynamic Wizard.
Note
When running the Update of the picture objects wizard, Template Picture and Control 
File fields in the dialog that appears should not exceed 256 characters.

4. Follow the prompts to update the active picture or select the option Yes, all pictures to 
update all pictures in the project. Then click the "Next" button to continue.

5. In the Options dialog that appears, in the field labeled Please specify the name of the 
template picture, click the ellipsis (...) button and select the picture file 
@@MyProjectTypicals.pdl (or @MyProjectTypicals.pdl if you have created this file as a copy of 
@@MyProjectTypicals.pdl and added modifications to it).

6. Do not change the field labeled Please specify a name for the control file field.
7. Click the "Next" button, then the "Finish" button to continue. The wizard updates all the 

graphic windows containing the modified block icons.
8. If problems occur, refer to the ChangeObjects.log file.
9. Close WinCC.

3.4 Updating the DBA Project 

Procedure
1. Open the DBA Utility (DBA) by selecting Start > SIMATIC > DBA > PCS 7 DBA.
2. Select File > Open.
3. Navigate to the existing DBA project and open it.

The following message appears:
"This DBA project was not created with the same version of the DBA Utility that you are 
using. Do you want to convert the DBA project to current version?"

Updating a Project from V8.2.1 and V9.0 to V9.1
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4. Click the "OK" button.
Note
During the update process, DBA compares existing Extended Attributes with their 
default values to determine if there is a significant enough change to the type 
definition to warrant discarding all Extended Attributes and replacing them with their 
default values.  This may introduce unintended changes for some customers who have 
made significant Extended Attribute changes in their DBA project.  In order to make 
sure that all customized Extended Attributes are preserved during the upgrade the 
following steps should be performed.

1. Export the Attributes from the AS View for each AS Source Node (Immediately before Step 
5 below)
2. Perform Update Controller Objects (Step 5 below)
3. Import the Attributes from the AS View for each AS Source Node (Immediately after Step 
5 below)

5. In DBA, right-click anywhere in the AS View pane (lower left) and select Update All 
Controller Objects.

6. Examine any warnings and resolve any errors (there should be none) in the Command 
Status dialog that follows.

7. Compile the DBA project to the PCS 7 OS by clicking the "Compile" toolbar button or selecting 
the menu command Run > Start Compilation. The Compile window opens.

8. Configure the options as follows:
– Select Entire OS 
– Select Tags and Messages
– Select Create/Update Block Icons
– Select Picture Tree
– Clear Create Archive Tags 

9. Start OS compilation by clicking the "Compile" button. 
10.Resolve any Validation or Compilation errors (none should occur).

Updating a Project from V8.2.1 and V9.0 to V9.1
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3.5 Updating the AS Nodes
Once a project is migrated to PCS 7/Open OS V9.1, follow the steps as given below:
1. Run the AS Node Wizard and build all the Nodes again without changing the configuration.
2. Update the Nodes in DBA Project.

Updating a Project from V8.2.1 and V9.0 to V9.1
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Project Engineering Overview 4
Engineering a PCS 7/Open OS project can be divided into the following high level tasks.

Task Description Section
1 Creating a PCS 7/Open OS Project (Page 35) 4.1
2 Third-Party Controller/Device Configuration/Programming (Page 35) 4.2
3 Integrating Controllers/Devices into PCS 7/Open OS (Page 35) 4.3
4 Configuring PCS 7/Open OS Stations (Page 35) 4.4

4.1 Creating a PCS 7/Open OS Project
A PCS 7/Open OS project is created using SIMATIC Manager. The process is described in detail 
in Creating a SIMATIC Manager Project (Page 37). This includes descriptions of how to 
configure all of the PC Stations in your system. Once these steps have been completed, the 
framework for additional engineering and maintaining your system is in place.

4.2 Third-Party Controller/Device Configuration/Programming
Controllers and other devices to be integrated with PCS 7/Open OS must be configured and/or 
programmed using the appropriate engineering tools, as provided by the vendor of the third 
party controller or device.

4.3 Integrating Controllers/Devices into PCS 7/Open OS
Integrating third-party devices or controller also may require the following:
• Providing and configuring network connections to the devices
• Providing and configuring gateway software to communicate with the devices, such as the 

configuration of an OPC Server
The scope of this effort depends on the devices being integrated and is dependent on the nature 
of the devices and mechanisms that are available for communicating with the device.

4.4 Configuring PCS 7/Open OS Stations
Once a Simatic Manager has been created, the objects of the Bailey system must be made 
accessible in PCS 7/90 OS stations. To do this, a  tool is provided, PCS 7/90 OS DBA, that 
simplifies this process.
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DBA provides:
• Automatic generation of the PCS 7/90 OS OS database including display hierarchy, needed 

variables, alarms, alarm-messages and priorities as well as function block symbols and 
faceplates.

• Automatic placing of type specific function block symbols and automatic assignment with 
faceplate.

The details of using DBA are provided in the PCS 7/90 OS DBA User’s Guide. This document 
includes step-by-step instructions for defining and directing the  process.

4.4.1 Completing the PCS 7 OS Database Configuration
Once the PCS 7 OS database has been generated by DBA, the following additional configuration 
steps complete the PCS 7 OS database configuration.

4.4.1.1 Completing Graphic Displays
Based on the system hierarchy configured in DBA, and the placement of AS objects within this 
hierarchy, DBA automatically creates the dynamic portion of all graphic displays. Symbols for 
each object are automatically placed, in a tiled manner, in each picture.

Procedure:
To complete the graphic displays, create the appropriate static elements (pipes, tanks and so on) 
and move the already-created dynamic symbols to the desired position on the graphic.

4.4.1.2 User Administration
PCS 7 allows user rights to be established based on the layout of the system hierarchy. The 
highest level of this hierarchy is divided into Areas. This hierarchy, once configured in DBA, is 
automatically created in the PCS 7 database.
For more details on configuring Area-based User Administration, refer to the help file:
Start > Simatic > WinCC > WinCC Information System > Working With WinCC > Setting up 
User Administration

4.4.1.3 Downloading OS Databases
In a client/server architecture, all PCS 7 OS databases (both client and server) need to be 
downloaded to the OS stations.
The process of downloading PCS 7 OS projects to PC Stations is described in detail in Chapter 
Downloading and Activating PCS 7 OS Stations (Page 65).

Project Engineering Overview
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Creating a SIMATIC Manager Project 5
If you are integrating third-party controllers or other devices to an already existing SIMATIC 
Manager project, the steps outlined in this chapter are not required. Otherwise, this chapter 
provides step-by-step guidance to create a SIMATIC Manager project.
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5.1 Creating a New Project in SIMATIC Manager
1. Open SIMATIC Manager, Start > SIMATIC > SIMATIC Manager

The PCS 7 Wizard ‘New Project’ dialog box opens.
Note
Press the "F1" function key for help on each screen of the PCS 7 New Project Wizard.

2. Click the "Next" button.
The "Which CPU are you using in your project?" dialog box opens. 

Creating a SIMATIC Manager Project
5.1 Creating a New Project in SIMATIC Manager
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The selections on this page are only relevant for dual-leg projects (which include S7 
controllers configured in SIMATIC Manager in addition to AS nodes configured with DBA). For 
projects that do not include S7 controllers, accept the default settings. For projects that do 
include S7 controllers refer to the S7 user documentation or press the "Help" button for more 
details.

Creating a SIMATIC Manager Project
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3. Click the "Next" button to accept the default.
The dialog box labeled "Which objects are you still using?" opens. 

– In the Plant Hierarchy area, the "Number of levels" should be configured when using 
S7-400 controllers in the same OS project as DBA-configured AS Nodes. It should be set 
to the same value used in DBA.

– In the AS objects area, clear "CFC chart" and "SFC chart" check boxes. The CFC and SFC 
selections on this page are only relevant for S7 projects. For S7 projects refer to the S7 user 
documentation or press the "Help" button for assistance.

– In the OS objects area, select the "PCS7 OS" check box, and the appropriate system type.
Single station system – a single PC station will be created with an OS project. 
Multiple station system – two PC stations will be created, an OS server project, and an 
OS client project. 
Multiple station system redundant – three PC stations will be created, two OS server 
projects and an OS client project.
Note
If your project requires additional server or client stations, they can be added once the 
wizard steps have completed. Refer to Process Control System PCS 7 Engineering System 
Configuration Manual for details regarding adding additional PC Stations.

Creating a SIMATIC Manager Project
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4. Click the "Next" button.
The dialog box labeled "Where do you want to store the project?" (or "multiproject") opens. 

– In the Directory name box, enter a directory folder name or accept the default. This is the 
folder name for the directory under which the client/server projects will be created.

– In the Storage location (path) box, enter a path or accept the default. This path is where 
the directory folder will be located. This is the path for the master project on the 
engineering station.

5. Click the "Finish" button.
6. Accept the default. Click the "OK" button.

The project is created. This setting applies to projects that include S7-400 controllers and 
does not apply to messages created by DBA. 

5.2 Server Project Setup
The following steps are required to configure a PCS 7 OS Server project in SIMATIC Manager:

Step Section
Creating Shared Folders (Page 42) 5.2.1
Configuring Primary Station (Page 42) 5.2.2
Configuring Standby Station (Page 44) 5.2.3
Running OS Project Editor (Page 46) 5.2.4

Creating a SIMATIC Manager Project
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Step Section
Generating Server Data (Page 48) 5.2.5
Configuring Alarm Logging (Page 48) 5.2.6
Configuring Tag Logging (Page 48) 5.2.7

Note
PCS 7 OS stations must also be configured under PC Stations in your corresponding DBA Project. 
Refer to Chapter 5 of the PCS 7/90 OS DBA User’s Guide for details concerning  the configuration 
of PC Stations in DBA.

5.2.1 Creating Shared Folders
Shared folders on the servers are needed to store the project created on the Engineering Station. 
When the project is downloaded, it will be transferred from the Engineering Station to these 
folders. You cannot configure your stations in SIMATIC Manager until these folders are created 
and properly set up. Follow these steps to create and set up these folders, if they don’t already 
exist.
Shared folders must be created for both Primary and Standby Servers.

5.2.2 Configuring Primary Station
Identify the path to which the project will be downloaded on the Primary Server.

Creating a SIMATIC Manager Project
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Follow these steps:
1. In the Component View of SIMATIC Manager, right-click the PC Station that is the Primary 

Server and select "Object Properties". For example, if your Primary Server PC Station is 
SIMATIC PC Station(1) in the figure below, right-click on "SIMATIC PC Station(1)".

2. In the General tab, enter the computer name of the primary computer in both the "Name" 
and "Computer name" fields. These names must be entered in ALL CAPS. Click the "OK" 
button.

3. Right-click "OS(1)", and select "Object Properties".
4. The "Properties" dialog box opens.

Creating a SIMATIC Manager Project
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5. Rename, as desired, the "OS(1)" to the Server Project name.

6. Click the Target OS and Standby OS Computer tab.
7. Select the "Network" button to browse and map to the shared project folder on OS Server. If 

a mapped drive already exists, select it from the available drives listed in the "Load In" list box. 
This is the path to the folder on your primary server where you will store and operate the 
project. This path must include the network name of the target computer.
Note
This folder must already exist on the primary and standby servers and be shared. This folder’s 
permissions should be set to "Full Control" for "Everyone". Refer to section Create New Folders 
on the Primary and Standby Servers and All Clients in this document.

8. Click the "OK" button.

5.2.3 Configuring Standby Station
Identify the path to which the project will be downloaded on the Standby Server.

Creating a SIMATIC Manager Project
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Follow these steps:
1. In the Component View of SIMATIC Manager, right-click the PC Station that is the Standby 

Server and select "Object Properties".  For example, if your Standby Server PC Stations is 
SIMATIC PC Station(2) in the figure below, right-click on "SIMATIC PC Station(2)".

2. In the General tab, enter the computer name of the standby computer in both the "Name" 
and "Computer name" fields. These names must be entered in ALL CAPS. Click the "OK" 
button.

3. Right-click "OS(1)_StBy", and select "Object Properties". The default project name of Primary 
Server/Project Name_StBy must be used.
The "Properties" dialog box opens. 

Creating a SIMATIC Manager Project
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4. Click the Target OS and Standby OS Computers tab.

5. Select the "Network" button to browse and map to the shared project folder on OS Server. If 
a mapped drive already exists, select it from the available drives listed in the "Load In" list box. 
This is the path to the folder on your primary server where you will store and operate the 
project. This path must include the network name of the target computer.
Note
This folder must already exist on the primary and standby servers and be shared. This folder’s 
permissions should be set to "Full Control" for "Everyone". Refer to section Create New Folders 
on the Primary and Standby Servers and All Clients in this document.

6. Click the "OK" button.

5.2.4 Running OS Project Editor

Creating a SIMATIC Manager Project
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Note
While this step allows some customization of the screen layout, etc., it is required even if 
no customizations are to be configured, since this edtior also creates configuration data 
that is required for building DBA projects.     If no customizations are required, simply select 
all defaults.

If you want to change your layout, screen resolution, monitor configuration, message 
configuration, message display, area, runtime window, or basic data, run the OS Project Editor 
from WinCC Explorer. When configuring servers that will not be used as clients, it is 
recommended to use the SIMATIC server layout. 
To run the OS Project Editor:
1. In the Component view of SIMATIC Manager, right-click the WinCC OS application and select 

"Open Object". For example, if you want to run the OS Project Editor on the application OS(1) 
in the figure below, right-click on "OS(1)". This will open the application using WinCC Explorer.

2. Select the OS Project Editor and make any desired changes. Refer to online help as you are 
running the OS Project Editor for more details.

Creating a SIMATIC Manager Project
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5.2.5 Generating Server Data
1. From the Component view in SIMATIC Manager, right-click the primary OS server project, and 

select "Generate Server Data".
When the procedure is complete, a window opens containing the message, "The server data 
are generated successfully". 

2. Perform this procedure for each primary OS server.

5.2.6 Configuring Alarm Logging
For further information, refer to the help file Start > SIMATIC > WinCC > WinCC Information 
System > Working with WinCC > Setting Up a Message System.

5.2.7 Configuring Tag Logging
For further information, refer to the help file Start > SIMATIC > WinCC > WinCC Information 
System > Working with WinCC > Archiving Process Values.

Note
When using the Tag Logging Wizard, it is recommended that you name the archive 
SystemArchive for compatibility with PCS 7 trending faceplates.

5.3 Client Project Setup
For every client in the system, the following configuration steps are required:

Step Section
Creating Shared Folders (Page 49) 5.3.1
Configuring Client Station (Page 49) 5.3.2
Assigning OS Server (Page 51) 5.3.3
Configuring a Standard Server (Page 52) 5.3.4
Configuring a Preferred Server (Page 52) 5.3.5
Running OS Project Editor (optional) (Page 52) 5.3.6
Lifebeat Monitoring Setup (Page 54) 5.3.7
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5.3.1 Creating Shared Folders
Shared folders on the clients are needed to store the project created on the Engineering Station. 
When the project is downloaded, it will be transferred from the Engineering Station to these 
folders. You cannot configure your stations in SIMATIC Manager until these folders are created 
and properly set up. Follow these steps to create and set up these folders, if they don’t already 
exist.
Shared folders must be created for all Clients. 

See also
Creating Shared Folders (Page 42)

5.3.2 Configuring Client Station
Identify the path to which the project will be downloaded on the Client.

Note
If your client is not the same computer as your OS Engineering Station, then perform the 
following steps.

Creating a SIMATIC Manager Project
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Follow these steps:
1. In the Component View of SIMATIC Manager, right-click the PC Station that is the Client to be 

configured and select "Object Properties". For example, if your Client Server PC Stations is 
SIMATIC PC Station (3) in the figure below, right-click on "SIMATIC PC Station(3)".

2. In the General tab, enter the computer name of the client computer in both the Name and 
Computer name fields. These names must be entered in ALL CAPS. Click the "OK" button.

3. Right-click "OSC(3)", and select "Object Properties".
The "Properties" dialog box opens. 

4. Rename, as desired, the OSC(3) to the client project name.

Creating a SIMATIC Manager Project
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5. Click the Target OS tab.

6. Select the "Network" button to browse and map to the shared project folder on OS Server. If 
a mapped drive already exists, select it from the available drives listed in the "Load In" list box. 
This is the path to the folder on your primary server where you will store and operate the 
project. This path must include the network name of the target computer.
Note
This folder must already exist on the primary and standby servers and be shared. This folder’s 
permissions should be set to "Full Control" for "Everyone". Refer to section Create New Folders 
on the Primary and Standby Servers and All Clients in this document. 

7. Click the "OK" button.
8. From the Component view, add and configure additional clients, servers, and server pairs as 

needed. You can add up to a total of 32 clients and 12 server pairs.

5.3.3 Assigning OS Server
1. From the Component view in SIMATIC Manager, right-click OS Client and select "Assign OS 

server…" The OS server assignment window opens.
2. Check the Project check box for each server as needed, and click the "OK" button. A progress 

bar indicating the status opens. When the procedure is complete, a window opens with the 
message, "The Procedure was complete without error".

3. Click the "OK" button.

Creating a SIMATIC Manager Project
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5.3.4 Configuring a Standard Server

Note
The "Standard Server" represents the Server or Server pair that will store all operator actions and 
Runtime Trends. If a Standard Server is not configured, operator actions will be stored on the 
local machine instead of on the "Server". In addition, any Runtime Trends created will only be 
viewable from the client on which they are created.

On the OS Engineering Station, open the OS client project from SIMATIC Manager. Set up a 
standard server for Alarms and Split Screen Manager (SSM). 
1. Right-click on "Server Data".
2. Select "Standard Server".
3. Click on the "Symb. Computer Name" field next to the "Alarms" Component. From the drop-

down list, select the package that is the server for this client and is providing alarms for the 
client you are currently configuring.

4. Repeat step 3 for the "SSM" component.
5. Click the "OK" button.
This step can also be performed on the client after downloading the project to redefine the 
standard server for a particular client station. This customization will be overwritten during a 
subsequent download. 

5.3.5 Configuring a Preferred Server
For further information, please refer to the help file Start > SIMATIC > WinCC > WinCC 
Information System > Options > Options for Process Control > Preferred Server.
This step can also be performed on the client after downloading the project to customize the 
preferred server connection for a particular client station. This customization will be overwritten 
during a subsequent download.

5.3.6 Running OS Project Editor (optional)
If you want to change your layout, screen resolution, monitor configuration, message 
configuration, message display, area, runtime window, or basic data, run the OS project editor 
from WinCC Explorer. 
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To run the OS Project Editor:
1. In the Component view of SIMATIC Manager, right-click the WinCC OS application and select 

"Open Object". For example, if you want to run the OS Project Editor on the application 
OSC(3) in the figure below, right-click on "OSC(3)". This will open the application using WinCC 
Explorer.

2. Select the OS Project Editor and make any desired changes. Refer to online help as you are 
running the OS Project Editor for more details.
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5.3.7 Lifebeat Monitoring Setup
1. Open the client project. From the Component view in SIMATIC Manager, right-click on the OS 

client project and select "Open Object". 
The project opens in WinCC Explorer.

2. Right-click "Lifebeat Monitoring" and select "Open". 
The "Lifebeat Monitoring" window is displayed.
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3. Set the Device positioning in the system configuration to automatic. Select a Monitoring 
Cycle time, and then click the "Update" button.
When complete, the system configuration section will update. See the Lifebeat Monitoring 
window below.

4. Lifebeat Monitor setup on the client is complete. Click the "Close" button to close Lifebeat 
Monitoring. 

5.4 Configuring the Terminal Bus
For Engineering Station, Central Archive Server and Client and Server PCs:
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If the PC (computer) has more than one network adapter, configure WinCC for the network 
adapter it will be using. 
1. Open Windows Explorer and select My Computer > SIMATIC Shell > Settings. 

The "Terminal bus selection" window opens.

2. Select the appropriate network adapter.  Click "OK".
The message box "Network communications need to be initialized" opens. 

3. Click "Yes".

WinCC Communications Configurator
The WinCC Communications Configurator configures WinCC to use different network speeds (for 
example,  for dial-up or radio)
1. To start, click Start > Simatic > WinCC > Tools > Communication Configurator.

– Slide bar should be set to reflect network speed.
– "Server Pings Client" should be set unless there are dial-up clients.
– Settings should only be changed if CCAgent, CCClient, and CCServer processes have been 

(manually) stopped.
Note
Refer to WinCC Help for additional details regarding WinCC Communication Configurator.

5.5 Time Synchronization Setup
For Clients and Server PCs: 
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For further information, please refer to the help file Start > SIMATIC > WinCC > WinCC 
Information System > Options > Options for Process Control > Time Synchronization. 

5.6 User Administration
It is possible to configure all user accounts.  For more details on configuring user accounts, refer 
to the help file:
Start > Simatic > WinCC > WinCC Information System > Working With WinCC > Setting up 
User Administration 

5.7 Data Security and Backup

Recommendation
Save the various project states.
Create a backup in the following situations:
• After configuration changes
• Before and after system component upgrades
• Before and after the software update of the configuration software

Additional Information
You will find a step-by-step description of saving and backing up ES and OS project data in the 
Process Control System PCS 7 and PCS 7 Service Support and Diagnostics manuals.

Important
 It is recommended that your DBA Project also be stored in a folder within your SIMATIC Manager 
project folder, so that archiving the SIMATIC Manager project will include all project data.
For example, if you create a SIMATIC Manager project called S7Pro_1, a folder hierarchy is 
automatically created:

Creating a SIMATIC Manager Project
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Expanding the S7Pr_Prj directory shows many additional subfolders that are created 
automatically.

Create a new folder called DBA in the S7Pr_Prj subdirectory:

Your DBA project should be created in this subdirectory. This ensures that the DBA project will be 
automatically backed up and restored using the standard backup and restore procedures 
described in Process Control System PCS 7 and PCS 7 Service Support and Diagnostics manuals.
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Connection Monitoring 6
6.1 Overview

PCS 7 provides a concept of Lifebeat Monitoring to offer some capabilities to monitor the health 
of the connection between PCS 7 OS. You can find a detailed description of the configuration 
under "Lifebeat Monitoring" in the WinCC Information System Online Help.
While Lifebeat Monitoring may provide rudimentary information regarding connectivity with a 
third-party device or controller, in some cases more sophisticated diagnostic capabilities may be 
desired and can be implemented on a per project basis.
The sections below describe some common enhancements that might be applied to achieve 
more advanced diagnostic capabilities.
In the case of native WinCC Channels (non-OPC), connection diagnostic data that is available 
may be tag data available in a controller or other device, or special “system tags” that the channel 
provides that offers additional diagnostic data, such as connection status or a lifebeat. Refer to 
documentation for the channel being used to determine what diagnostic data might be 
available.
In the case of OPC connections, connection diagnostic data that is available may be data 
available in a controller or other device, or special “system tags” that the OPC Server provides that 
offers additional diagnostic data, such as connection status or a lifebeat. Refer to the 
documentation provided by the vendor of the OPC Server to determine what diagnostic data 
might be available.

6.2 Common Project Enhancements

Common Project Enhancements

Common project enhancements include the following:
1. The user may want to provide a visual indication of the health of the connection to the 

controller and/or its WinCC Channel or OPC Server even if the lifebeat monitoring screen is 
not currently displayed.

2. The user may want to trigger alarm messages based on the health of the connection to the 
controller and/or its WinCC Channel or OPC Server.

3. In a redundant server architecture, the user may want to shut down one of the servers based 
(in part) on the health of the connection to the controller and/or its WinCC Channel or OPC 
Server.  Clients could then automatically switch to the other redundant server if it is available.

4. In a redundant server architecture, the user may choose to leave all servers running, but force 
clients to switch servers based (in part) on the health of the connection to the controller and/
or its WinCC Channel or OPC Server.
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This section will provide an overview of methods that can be used to monitor the health of the 
connection to the controller and/or its WinCC Channel or OPC Server, and methods to provide the 
desired system response.  Implementation details are left to the user since each system is unique.

6.3 Monitoring Options
Monitoring the health of the connection to the controller and/or its WinCC Channel or OPC 
Server
This section will provide an overview of methods that can be used to monitor the health of the 
connection to the controller and/or its WinCC Channel or OPC Server, and methods to provide the 
desired system response. Implementation details are left to the user since each system is unique.

6.3.1 Monitoring Option 1: Constantly Changing Tag Value
A convenient way to monitor the connection to a controller and/or its WinCC Channel or OPC 
Server is to monitor a tag whose value is constantly changing such as "time of day", "scan cycle", 
or "heartbeat" type of tags. If the controller itself does not provide such a tag (and the user is not 
able to add one to the controller configuration), then it is possible that the WinCC Channel or OPC 
Server provides a similar tag. The timestamp of each tag value change can be recorded, and if 
the value does not change by a user determined timeout period (for example, 10 seconds), then 
the connection can be marked as bad. This can be implemented in C-Script through the use of 
the GetTagDWord() (or similar) function to read the tag value, and the time() function to read 
the current time.

6.3.2 Monitoring Option 2: Fixed Tag Value
If a tag whose value is constantly changing is not available in the controller or WinCC Channel 
or OPC Server, then it is possible that the controller or WinCC Channel or OPC Server provides a 
dedicated tag to indicate health based on its value (for example, a .STATUS tag is available where 
0 means "Good" and 1 means "Bad"). This can be implemented in C-Script through the use of the 
GetTagDWord() (or similar) function to read the tag value.

6.3.3 Monitoring Option 3: Tag State and Quality Code
If neither of the above two methods are appropriate for a given system, then the user can choose 
to monitor the tag state or tag quality code of any tag in the system. This can be implemented 
in C-Script through the use of the GetTagDWordState() or GetTagDWordStateQC() (or similar) 
function to read the tag state or quality code.
Regardless of which of the above three approaches are used, the user will need to create internal 
PCS 7 OS tags to store tag value, tag status, tag quality code, tag read time, and the result of the 
health determination.

Connection Monitoring
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6.4 Providing Appropriate System Response

Providing the appropriate system response based on the health of the connection to the controller 
and/or its WinCC Channel or OPC Server

Once the result of the health determination is available as an internal PCS 7 OS tag, it can be used 
to drive the appropriate system response. For illustration purposes, this tag will be referred to as 
ConnectionStatus, but the user is free to choose any appropriate tag name.

System Response Option 1: Provide a Visual Indication
You may want to use ConnectionStatus to drive an indicator on the overview1.pdl file. Placing 
the indicator on the overview1.pdl file means it will always be visible to the operator regardless 
of which user graphic is being displayed in the working window. This might be similar to the 
RedundancyStateIndicator, whose color changes based on the redundancy state (green for 
good, and red for bad).

System Response Option 2: Provide an Alarm Message
You may want to use ConnectionStatus to trigger one or more alarm messages. The user would 
configure this using the existing PCS 7 Alarm Logging Editor.

System Response Option 3: Server Shutdown
In a redundant server architecture, the user may want to use ConnectionStatus to take a server 
out of runtime. Clients could then automatically switch to the other redundant server if it was 
available. ConnectionStatus should probably not be the only triggering factor since you probably 
would not want to shut down the server if it is providing other services (like communicating to 
other controllers) or if the redundant server was not available. This can be implemented in C-
Script through the use of the DeactivateRTProject() function.

6.4.1 System Response Option 4: Client Switchover

System Response Option 4: Client Switchover
In a redundant server architecture, the user may want to use ConnectionStatus to force a client 
to switch to the other server. This can be implemented in C-Script through the use of the 
SetTagBit("@RM_MASTER", 0) function. This forces the current server into standby mode. The 
redundant server will take over the master server role if it was previously in the standby role. 
Clients who do not have a preferred server configured, will automatically switch to the new 
master server.

Connection Monitoring
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Downloading and Activating PCS 7 OS Stations 7
Downloading

Procedures vary depending upon the target of the download.

Activating and Reactivating
Perform activation and reactivation in the prescribed order. 

7.1 Downloading the Project to the Primary Server
1. From SIMATIC Manager component view, right-click the Primary Server OS (PC Station 1), 

and select PLC > Download.
2. Ensure that "The Entire WinCC Project" radio button is selected. 
3. Click "OK" to download the project. 
4. A success window is displayed. Click "OK" to acknowledge that the download has completed.
5. Reload the Rovisys OPC90 Server on  the Primary Server. Refer to the section Bailey 

Engineering Database Change Management below  for details concerning the steps required 
to reload the OPC90 Server on a Server station.    

7.2 Downloading the Project to the Standby Server
1. From SIMATIC Manager component view, right-click the Standby Server OS (PC Station 2), 

and select PLC > Download.
2. Ensure that "The Entire WinCC Project" radio button is selected. 
3. Click "OK" to download the project. 
4. A success window is displayed. Click "OK" to acknowledge that the download has completed.
5. Reload the Rovisys OPC90 Server on  the Standby Server. Refer to the section Bailey 

Engineering Database Change Management below  for details concerning the steps required 
to reload the OPC90 Server on a Server station.   

7.3 Downloading the Project to the Client Station
1. From SIMATIC Manager component view, right-click the Client Station OS (PC Station 3), and 

select PLC > Download.
2. Ensure that "The Entire WinCC Project" radio button is selected. 
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3. Click "OK" to download the project. 
4. A success window is displayed. Click "OK" to acknowledge that the download has completed.

7.4 Activating Server Projects
Note
Projects can be automatically activated when the operating system starts using the AutoStart 
Utility. For more information, refer to the help file within WinCC Explorer, or to FAQ ID: 19249315

1. Activate the project on the primary server.
2. Wait four minutes for the project to fully start.
3. Activate the project on the backup server.
4. Wait four minutes for the project to fully start.
5. Activate the project on the client.

7.5 Restarting an OS Server
Wait five minutes before reactivating the WinCC runtime of an OS Server associated with a 
redundant pair to ensure that all synchronization activities will start-up properly. 

Downloading and Activating PCS 7 OS Stations
7.5 Restarting an OS Server
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Delta Engineering 8
This section describes how to make changes to an existing project from the Engineering Station, 
and then downloading those changes into the servers and client. These changes may include:
• Making changes to an AS program
• Adding or removing a station
• Making changes to the plant view in DBA
• Making changes to the project in SIMATIC Manager
• Making changes to the project in WinCC

8.1 Overall Steps
1. Make changes. Ensure that DBA changes have been compiled. 
2. Download changes to your stations. 

8.2 Making Changes to the AS Configuration
If necessary, use the appropriate Bailey or other third-party tools to make changes to AS Station 
programs or hardware configurartion.
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8.3 Making Changes to the DBA Configuration
1. If you have made changes to your AS programs or hardware configuration, make any 

necessary corresponding changes to your DBA project (efor example, adding new object 
instances).

2. Use DBA to make any additional changes desired, such as
– Fine-tuning of the Plant View assignments
– Renaming folders or graphic files assigned to folders
– Editing of AS Object attributes such as Symbol Names and Alarm Priorities (see DBA Help 

File, section Object Attributes, for more details)
3. From DBA, select Compile. If you have made changes to any DBA Types using the Type Editor, 

choose the "Entire OS" option. Otherwise, you may choose the Changes option on the 
compile dialog box:

8.4 Modifying the Project in WinCC
1. On the OS Engineering Station, start WinCC Explorer and open the OS Server project.
2. Make any new changes to the project that you need (for example, create new graphics, 

modify existing graphics, etc.).

Note
All changes must be made on the OS Engineering Station to preserve the Changes Only 
download. Changes made on another station cannot be downloaded to the other stations via 
SIMATIC Manager. These changes would have to be downloaded manually. Changes made on 
any station other than the Engineering Station will require a full download when future changes 
are made. 

Delta Engineering
8.4 Modifying the Project in WinCC
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8.5 Downloading Changes
There are two methods to download changes:
• Load Online Changes (Delta Download)

Note
Important
If you have removed objects from the Plant View in DBA and loaded online changes, and later 
re-added the same object back to the Plant View in DBA, do not use Load Online Changes to 
download these changes.    In order for these objects to operate correctly in runtime, it is 
necessary to download these changes use Full Download. 

• Full Download
Note
Certain changes made in DBA will require that the Full Compile method be used. You will be 
warned within DBA when attempting to make such changes that a Full Compile will be 
required.

8.5.1 Full Download

8.5.1.1 Downloading the Project to the Standby Server
1. If WinCC runtime is activated on the server and you are downloading changes that add, 

modify or delete any tags that are to be accessed by the OPC90 Server, deactivate the Standby 
Server.

2. From SIMATIC Manager component view, right-click the Standby Server OS  and select PLC > 
Download.

3. Ensure that "The Entire WinCC Project" radio button is selected. 
4. Click "OK" to download the project. 
5. A success window is displayed. Click "OK" to acknowledge that the download has completed.
6. If you have downloaded changes that add, modify or delete any tags that are to be accessed 

by the Rovisys OPC90 Server,  reload the Rovisys OPC90 Server on  the Standy Server. Refer 
to the section Bailey Engineering Database Change Management below  for details 
concerning the steps required to reload the Rovisys OPC90 Server on a Server station.    

7. If the download was started with the WinCC Runtime deactivated, reactivate the WinCC 
runtime.

Delta Engineering
8.5 Downloading Changes

PCS 7/Open OS Setup Guide
Equipment Manual, 11/2021, A5E51387645-AA 69



8.5.1.2 Downloading the Project to the Primary Server
1. If you are downloading changes that add, modify or delete any tags that are to be accessed 

by the OPC90 Server, deactivate the Primary Server.
2. From SIMATIC Manager component view, right-click the Primary Server OS (PC Station 1), 

and select PLC > Download.
3. Ensure that "The Entire WinCC Project" radio button is selected. 
4. Click "OK" to download the project. 
5. A success window is displayed. Click "OK" to acknowledge that the download has completed.
6. If you have downloaded changes that add, modify or delete any tags that are to be accessed 

by the OPC90 Server,  reload the OPC90 Server on  the Primary Server. Refer to the section 
Bailey Engineering Database Change Management below  for details concerning the steps 
required to reload the OPC90 Server on a Server station.

7. If the download was started with the WinCC Runtime deactivated, reactivate the WinCC 
runtime.

8.5.2 Downloading Changes

8.5.2.1 Loading Online Changes

Load Online Changes (Delta Download)
You can only download changes when all stations have PCS 7 activated. Unlike downloading the 
entire project, you do not need to explicitly request a download to the Standby Server. The 
download to the Primary Server will automatically include the Standby Server. You will not 
explicitly see the changes downloaded to the Client, as this download is done in the background.

1. From SIMATIC Manager component view, right-click the "Primary Server OS" (PC Station and 
select PLC > Download.

2. Ensure that "Changes" radio button is selected. 
(Note : In a redundant system, this choice is only available if both the Master and Standby are 
both online.)

3. Click "OK" to download the changes. When downloading to redundant servers, the 
configured Standby will be downloaded first).

4. A success window is displayed. Click "OK" to acknowledge that the download has completed.
5. In a redundant system, the configured Master will then be downloaded and the "OK" button 

will again become available once this download is complete. Select "OK" to acknowledge the 
download.

For more details concerning Loading Online Changes, refer to SIMATIC Process Control System 
PCS 7 V9.1 documentation.
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Product Installation Guidance Tables 9
9.1 PCS 7/Open OS Option V9.1

Component Station
 Eng. Sta‐

tion 
OS Serv‐
er 

OS Client OS Sin‐
gle Sta‐
tion 

PCS 7/Open OS Single Station    X
PCS 7/Open OS Client   X  
PCS 7/Open OS Server  X   
PCS 7/Open DBA X    
Customized Installation     
PCS 7 DBA X    
PCS 7/Open Faceplates and Symbols X X X X
PCS 7/Open OS DBA X    
PCS7/OPC DBA X    
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